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Dear Technology Leader:

Want to make this school year a smashing success? Put this set of outstanding technology-infused 
lesson plans into your teachers’ hands -- and then step out of the way.

Drawing on the exemplary work of technology-using classroom educators across the country and
themed especially for Fall and Winter, this fourth Microsoft Productivity in the Classroom workbook
is designed to make the most of your school’s Windows or Power Macintosh computers. The ten
lesson plans in this workbook were designed for use with both Microsoft® Office 97 Professional
Edition (Microsoft® Word 97, Microsoft® Excel 97, Microsoft® PowerPoint® 97 and Microsoft® Access 97)
for Windows and the new Microsoft® Office 98 Macintosh Edition (Microsoft® Word 98, Microsoft®

Excel 98, Microsoft® PowerPoint® 98). Many of the lessons also integrate other Windows products,
such as Microsoft® Publisher 98, Microsoft® FrontPage 98, and Microsoft® Encarta Encyclopedia Deluxe,
while taking advantage of online resources with Microsoft® Internet Explorer 4.0. All lessons include
step-by-step instructions for using software effectively while weaving it into the curriculum.

Developed by the editors of Scholastic’s Instructor and Electronic Learning in Your Classroom in part-
nership with Microsoft, this workbook can be an effective tool for staff technology training as well
as an instant idea bank for classroom teachers. We hope that it energizes your curriculum this sea-
son and inspires your teachers to try their own technology-powered projects all year long.

Sincerely,

Mickey Revenaugh
for Instructor/Electronic Learning in Your Classroom

P.S. More free resources to help teachers use technology are available at:

www.microsoft.com/education/k12/training.htm
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Lessons at-a-Glance

productivity in the

LESSON GRADE LEVELS TIME ALLOTTED

NO FLAKES LIKE
SNOWFLAKES!

DO VAMPIRES 
REALLY EXIST?

EXTREME WEATHER!

THE ART AND SCIENCE
OF FRACTALS

DESERT STORM,
REVISITED

Middle School/High School

High School

Middle School

High School

Intermediate

Primary/Intermediate

Intermediate

Intermediate

Three class periods

Two to three class periods

Two to three class periods,
and ongoing

Two to three class periods

Three to five class periods

One class period

One to two class periods

Five class periods

Two to three class periods

Middle School/High School

PrimaryA IS FOR AARDVARK
Two class periods to start,
ongoing as needed

classroom

THE YEAR OF 
THE RABBIT

WEIGHTS AND 
MEASURES

OUR BRILLIANT
CAREERS

LITERARY 
SCAVENGER HUNT



SOFTWARE NEEDED PAGE CURRICULUM CONNECTION

Language
Arts

Geography Math Science Art
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34

27

31

24

21

18

11

15

7

Microsoft Word 97/98

Microsoft Internet Explorer 4.0
Microsoft Encarta 98/99 Encyclopedia Deluxe
Microsoft Word 97/98
Microsoft Publisher 98

Microsoft Internet Explorer 4.0
Microsoft Paint (Windows 95/98 Accessory)
Microsoft PowerPoint 97/98

Microsoft Excel 97/98

Microsoft Encarta 98/99 Encyclopedia Deluxe
Microsoft Internet Explorer 4.0
Microsoft Word 97/98
Microsoft Front Page 98

Microsoft Internet Explorer 4.0
Microsoft Access 97/98

Microsoft Word 97/98
Microsoft Internet Explorer 4.0
Microsoft PowerPoint 97/98

Microsoft Internet Explorer 4.0
Microsoft Excel 97/98

Microsoft Encarta 98/99 Encyclopedia Deluxe
Microsoft Internet Explorer 4.0
Microsoft Publisher 98

Microsoft Encarta 98/99 Encyclopedia Deluxe
Microsoft Internet Explorer 4.0
Microsoft PowerPoint 97/98

Social
Studies



PRIMARY

A IS FOR AARDVARK

To master the art of reading,
kids should collect words the
way they collect baseball cards
or Beanie Babies. Few learning
tools are as powerful as a per-
sonal dictionary that a child
can create, add to, and use as
needed. This activity will help
you start an electronic dictio-
nary for your whole class.

♦ To build children's vocabu-
lary and spelling skills 

♦ To reinforce reading concepts 

♦ To provide fun practice
using technology 

♦ Basic introduction to
Microsoft Word 97/98, including
opening and saving files

♦ Ability to use clip art

Two class periods to get start-
ed; ongoing as needed

1. To organize your students’
work, you’ll want to create a
set of folders on a server or
computer accessible to all.
Name the main folder Our
Class Dictionary.  Inside this
folder, create a folder for each
letter of the alphabet. In

Windows 95/98, if you need
assistance, select Help, Help
Topics, then Index, and search
on Creating Folders. 

2. Using your class list, tenta-
tively assign a letter to each stu-
dent, but keep A for yourself. 

3. Demonstrate for students
how to use Word to create a
dictionary page template for
the letter A, following the
model above. (Step-by-step
instructions are repeated in
the Student Activity.) Show
kids how to use WordArt to
make a fancy letter A, upper
and lower case. Walk through
the process of inserting Text

Boxes and providing template
text for words, definitions, and
your name. Add another text
box to provide a placeholder
for clip art. Then show how to
Save As a template called
A.dot. Close the document.

4. Demonstrate for students
how, when you go to Word, File
and select New, the A template
appears in the General menu.
Double-click on A, and create a
page for an A word. Aardvark
is sure to get a giggle out of
your students, especially if
they're fans of the Arthur
series by Marc Brown.

5. Show students how to save
a dictionary page. When you
select the File menu and
choose Save, Word automati-
cally asks for a new file name
and indicates that it will save
as a Word Document, rather
than a template. Select your
"A" file folder, and save the
document as Aardvark (or
whatever it is).

6. Print out a copy of your
dictionary page. Explain that
you will add it to your own
personal dictionary notebook,
but that the whole class can
now easily look up Aardvark if
ever the need should arise.

7. Assign each student his or
her letter, and explain that you
will help each person set up an
alphabet letter template. 

REQUIRED SOFTWARE

♦ MICROSOFT® WORD 97/98

SUMMARY

OBJECTIVES

HOW TO BEGIN

PREREQUISITE SKILLS

TIME ALLOTTED
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Teacher Guide

With your help, even very young
learners can use Microsoft Word
97/98 to set up a dictionary page
template for each letter of the
alphabet, and then fill in a new
page for each word they learn. 



Just think of all the new words
you learn every day, from the
books you read and the stories
you write. Wouldn’t it be great
if you could save each one and
share it with your friends?
Now you can. Follow these
steps to make a special dictio-
nary that you can add new
words to all year.

Make a Letter
Template
SOFTWARE: Microsoft Word
97/98

WHAT TO DO: Remember
how your teacher made a dic-
tionary template page for the
letter A? Here's how you can
make one for the letter you
have been assigned.

1. In Word, go to File and
select New. Click on the
Template button in the bot-
tom right corner. Then dou-
ble-click Blank Document.

2. Go to Insert, choose Picture,
and then click on WordArt.

3. Choose a WordArt design
you like and click OK. A screen
will come up that says Your
Text Here. Type in your as-
signed letter, once as a capital
(big) letter and once as a lower
case (small) letter. Click OK. 

4. Click in the middle of your
WordArt design, and drag it to
the top left hand corner of the
page. You can also stretch it
by clicking and dragging on
one of the little boxes around

the edge of the design.

5. Click outside of your
WordArt design and press tab
a few times to get to the top
right corner of the page. Go to
Insert again, and this time
choose Text Box. Drag the
cross tool to make a box just
big enough for a kid's name.
Click inside it, and type the
words: Your Name.

6. Click outside the text box,
and press Enter a few times to
move down the page. Insert
another text box. Click in the
middle of it, then click on a
corner and drag it to make it
bigger. Click inside and type:
Enter Your Word Here. Go to
Edit, choose Select All, and
then go to the Format toolbar
and make your text bigger and
bolder.

7. Add another text box.
Inside this one, type: What
does your word mean?

8. Add another text box
underneath this one. Inside,
type: Put a picture here.

9. When you are happy with
your page design, go to File
and choose Save. Name your
file for your assigned letter. It
will automatically save as a
template.

Add a Word
SOFTWARE: Microsoft Word
97/98

WHAT TO DO: Now it's time to
make a your own dictionary
page using one of the tem-
plates you and your classmates
created. Here's how.

1. Choose a new word you've
just learned -- from a book you
have been reading, from some-
thing you saw in your class-
room, or from a piece of writ-
ing you've done.

STEP A

DESCRIPTION

A IS FOR AARDVARK
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Student Activity

STEP B

The WordArt feature of Microsoft Word 97/98 lets you make alphabet
letters in fun shapes and sizes for your dictionary pages.



2. On the computer, launch
Word, go to File, and choose
New. Open the letter template
you need.

3. Click the first text box once
so it is highlighted, and type in
your name. Repeat this step to
fill in the box for your word
(be sure it's spelled right!) and
what it means. For the text box
that asks for a picture, select
Insert, Picture, and Clip Art,
and choose a special illustra-
tion that will help you and
your classmates understand
what the word means.

4. Go to File and choose Save.
In Save In, choose the Our
Class Dictionary folder, and
open the folder inside for the
letter your word begins with.
Name your document for the
word it represents and click
Save.

5. Print out your page for your
personal dictionary.

6. Keep adding words to the
dictionary as you learn them.

Play a Word Game
SOFTWARE: Microsoft Word
97/98

WHAT TO DO: When everyone
has added words to the dictio-
nary, try a game like one of
these.

1. Scavenger Hunt: Challenge
your friends to find five new
words you've added to the dic-
tionary. Make up clues based
on what each word means,
how it's spelled, or what it
rhymes with. Open a new Word
document and type in your
clues. Leave a space after each
one for answers. Print out sev-
eral copies of the clue sheet
and see who fills one in first!

2. Silly Sentences: Team up
with three friends. Each play-
er should give the others one
letter each -- with no repeats.
Find one word in your class
dictionary for each letter your
teammates gave you. Then
make up a sentence using all
your words.

3. Quiz Whiz: Choose a part-
ner. While your partner sits at
the computer, sit with your
back to it. As your partner
calls out words from the dic-
tionary, try spelling them out
loud. Write down any you get
wrong, then go back to the
dictionary and study them.

A IS FOR AARDVARK
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Use Microsoft Word
97/98 to create a 
dictionary page tem-
plate for your letter of
the alphabet. Use
WordArt (see previous
page) to make a cool
letter heading. Then
Insert a Text Box for
your name, the word,
its definition, and a
picture. Save as a
Word Template. Then,
when you or your
classmates open a
New document in
Word , you can choose
this page and fill it in
with a word beginning
with that letter!

STEP C

Use all your dictionary pages to play word games with your friends!



PRIMARY/
INTERMEDIATE

THE YEAR 
OF THE RABBIT

According to the Chinese lunar
calendar, 1999 will be the Year
of the Rabbit. The New Year
will begin in mid-February, but
you can launch this cross-cur-
ricular unit anytime. Your stu-
dents will love it! 

♦ To introduce basic life sci-
ence concepts involving small
mammals, domestication, and
biodiversity 

♦ To prompt exploration of
geography and world cultures

♦ To discover connections
among favorites stories and
characters

♦ Basic research skills using
Microsoft Internet Explorer 4.0
and Microsoft Encarta 98/99
Encyclopedia Deluxe

♦ Fundamentals of Microsoft
Word 97/98 text processing 

♦ Introduction to Microsoft
Publisher 98 desktop publishing

5 class periods

1. Write each of the following
rabbit names on small slips of
paper, enough for the whole
class: cottontail, snowshoe rab-
bit, jackrabbit, Angora rabbit,
lop rabbit, Siberian rabbit, Pata-
gonian rabbit, and silver-tip
rabbit. Put the names in a hat.

2. Gather together as many
fiction and non-fiction books
about rabbits as you can find
in your school and classroom
library. Try to include all of
the books listed in the box on
page 10.

3. Introduce your students to
Chinese New Year, an ancient
celebration set by the lunar
calendar. It is celebrated in
Chinese communities in late
January or February.  New

Year is marked by the ascen-
dance of a particular animal
figure in the Chinese zodiac.
February 16, 1999 will mark
the new lunar year 4697. It will
be the Year of the Rabbit.

4. Tell students that they will
be spending the next week
exploring the amazing world
of rabbits from a number of
different viewpoints. Ask them
to come up one at a time and
draw a rabbit name out of the
hat. Students with the same
rabbit name will form a "rab-
bit family," working together
to research that particular
rabbit but also to find out
about make-believe rabbits
and what rabbits stand for in
different cultures. They will
share their findings with the
other students, then collabo-
rate as a class to create a Web
site to share what they've
learned with the world.

5. Provide each rabbit family
with a copy of the Student
Activity and have them get to
work.

6. While students are con-
ducting research, set up a
Year of the Rabbit bulletin
board or display area to show-
case their work.

REQUIRED SOFTWARE

♦ MICROSOFT® INTERNET 
EXPLORER 4.0

♦ MICROSOFT® ENCARTA® 98/99
ENCYCLOPEDIA DELUXE

♦ MICROSOFT® WORD 97/98

♦ MICROSOFT® PUBLISHER 98

OPTIONAL SOFTWARE

♦ MICROSOFT® ENCARTA® 98/99
VIRTUAL GLOBE 

SUMMARY

OBJECTIVES

HOW TO BEGIN

PREREQUISITE SKILLS

TIME ALLOTTED

Teacher Guide
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The Year of the Rabbit is coming!



Celebrate the Year of the
Rabbit by finding out about all
different kinds of rabbits - real
rabbits, storybook rabbits, and
more. You'll be working as part
of a group named for one par-
ticular kind of rabbit, and shar-
ing everything you discover
with your whole class. 

Meet Your Rabbit
Family
SOFTWARE: Microsoft
Encarta 98/99 Encyclopedia
Deluxe, Microsoft Internet
Explorer 4.0, Microsoft Word
97/98, Microsoft Encarta
98/99 Virtual Globe (optional) 

WHAT TO DO: Now that
you've been assigned to a
rabbit family, your first task
is to find out more about the
type of rabbit you're named
for. Here's how.

1. Open a new Word docu-
ment and type in the follow-
ing questions: What is our
name (regular and scientific)?
What do we look like? Where
do we live? What sets us
apart from other rabbits?
What's wonderful about being
this kind of rabbit? What's
hardest? 

2. Launch Encarta
Encyclopedia. Click on
Encyclopedia Articles. In the
Pinpointer tool that pops up,
type in Rabbits, then click on
Rabbits and Hares. Read the
article and look at the pic-
tures. If there is material you
want to save, go to Options,
and choose Copy. Paste your
findings into your Word docu-
ment after the appropriate
question.

3. Next, launch Internet
Explorer and search the
Internet for more information
about your rabbit family. You
might start with one of the
sites listed in the box on this

page. When you find sites
with lots of material about
your particular kind of rabbit,
add them to your Favorites.
You can also print out materi-
al from Web sites, or copy
and save it in your Word file.
Be sure to keep track of your
sources so you can credit
them in your final report.  

4. OPTIONAL: Launch Virtual
Globe. Based on the informa-
tion you have so far, call up
maps of the areas where your
rabbit family lives. Copy and
paste these maps into your
Word document. Just for fun,
check out the article that
describes Australia's rabbit
problem. Go to Find, choose
World Themes, and select
Introduced Species. Scroll
down to the subhead "Invited
Guests." Double click on the
picture titled "Animal Weeds."
Rabbits, rabbits everywhere!

5. Use the information you've
found so far to answer the
questions you started with.

STEP A

DESCRIPTION

THE YEAR OF THE RABBIT

Student Activity
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Rabbits, Rabbits, Rabbits

Electronic Zoo/NetVet Rabbits Page
http://netvet.wustl.edu/rabbits.htm

Wonderful World of Bunnies
http://www.ece.utexas.edu/~nbeach
/bunny.html

The Hazelford Warren - a rabbit
role-playing adventure!
http://www.rit.edu/~nrw3338/hazelfo
rd.html

The ShowBunny Gallery 
http://www.showbunny.com/gallery.
htm

Photos of more than 40 breeds
http://members.aol.com/arbanet/arb
a/web/photo.htm

You’ll find fascinating facts about rabbits and hares in Encarta
Encyclopedia Deluxe , such as the Snowshoe Hare’s ability to change
the color of its coat to match the season. 



Spread the Word
SOFTWARE: Microsoft Word
97/98, Microsoft Publisher 98

WHAT TO DO: In this step,
your group will translate all
you’ve learned about your
rabbit family into an easy-to-
read format to share with the
rest of the class.

1. Launch Publisher. In the
Catalog that appears, choose
Publications by Wizard. With
your teammates, look over the
designs for Newsletters and
Brochures. Which one might
work best to present the infor-
mation about your rabbit 
family?

2. Choose a Publication. Click
Start Wizard and follow the
steps. When you are finished,
import text and photos from
your Word document. In some
cases, you may want to go
back to your sources and
gather additional material.

3. Edit your text to fit the for-
mat you chose. If it's a newslet-
ter, you'll want to come up
with a clever name, such as
the Cottontail Courier. If it's a
brochure, you might want to
title it "All About Angoras."
Whichever format you use,
include a dateline that says,
"Year of the Rabbit-1999/4967."

4. Edit and format your mate-
rial to make it as interesting
as possible.

5. When your first draft is
complete, save your work and
print out a copy for your
teacher to review. 

6. Revise your work as need-
ed, then print out again and

make copies to share with the
class. Your teacher may also
want to display a copy on a
special Year of the Rabbit bul-
letin board.

Storybook
Rabbits
SOFTWARE: Microsoft
Publisher 98

WHAT TO DO: Now your group
will explore famous rabbits in
fiction.

1. Look through the books
your teacher has gathered,
and make a trip to the library
to find other fiction books fea-
turing rabbits. With your
group, choose one book or
story to focus on. If possible,
pick a rabbit tale that features
a rabbit from your family.

2. Read the story together,
paying particular attention to
the main rabbit character.
Keep notes about how this
character looks and acts.

3. When you are finished read-
ing the book, discuss the story

and its characters with your
teammates. If you were recom-
mending this book to a friend,
how would you describe it?

4. Launch Publisher, go to
Publications by Wizard, and
choose Flyers. Select a design
that you think will work best
to convey the information
about your fictional rabbit.

5. Use one text box on the
flyer to give basic information
about the book (title, author,
publisher, date of publication).
Use other text boxes to pro-
vide a description of the main
rabbit character, a summary of
the plot, and your group's
comments about the book.

6. If possible, scan the book
cover or an illustration from
the book to include in your
flyer. Or you could use one of
your rabbit pictures from Step
A, or draw your own illustra-
tion inspired by the book.

7. When your flyer is com-
plete, print it out for your
teacher to check. Revise and
print again to display on the
Year of the Rabbit bulletin
board.

THE YEAR OF THE RABBIT
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STEP C

Use Publisher to create a flyer describing your favorite fictional rab bit.

STEP B



THE YEAR OF THE RABBIT

Famous Rabbits
SOFTWARE: Microsoft
Internet Explorer 4.0,
Microsoft Publisher 98 

WHAT TO DO: Now it's time to
explore more rabbit characters,
familiar and not-so-familiar.

1. In your group, brain-
storm a list of all the rabbit
characters you can think
of, from movies, cartoons,
stories, folktales, nursery
rhymes, and more. Don't
forget Bugs Bunny,  the
White Rabbit from Alice in
Wonderland, and Thumper
from Bambi. Jot down a
sentence or two about
each character. Is the rab-
bit smart, even a little wily?
Timid? Curious? Quick? 

2. Share your list with the
class. Together, think
about the traits rabbit
characters seem to share. 

3. Now you'll track down
rabbit characters in folk
tales around the globe to
see if these same traits hold
true across cultures. As a
group, choose one of the
following culture areas to
focus on: Native American,
African American, Western
European, Russian/Eastern
European, African, Latin
American, or Asian. If two
groups choose the same area,
your teacher can assign you to
one or the other.

4. Use Internet Explorer to
check out the Web sites listed
and search for others contain-
ing folktales from your select-
ed part of the world. Your

school or town librarian can
help you find more.

5. When you've read several
folktales, choose your favorite.
Launch Publisher, go to
Publications by Wizard, and
choose Advertisements. Create
an ad for your folktale rabbit,
"selling" the character's most
prominent traits. Illustrate with
clipart. Print out and fine-tune.

6. Next, perform your folktale
for your class. Within your
group, choose one person to
be the narrator and the others
to act out the characters' parts.

7. After all the stories have
been told, talk with your class-
mates about the different ways
rabbits are seen around the
world.

8. Add your folktale advertise-
ments to the Year of the Rabbit
bulletin board.

A Hopping Web
Celebration
SOFTWARE: Microsoft
Publisher 98, Microsoft
Internet Explorer 4.0

WHAT TO DO: Now it's time to
share your Year of the Rabbit

celebration with the world.

1. As a class, plan a World
Wide Web site that presents
all your findings about rab-
bits. You'll need a home
page that lists the contents
of the site with links to indi-
vidual pages for your rabbit
family information, book fly-
ers, and rabbit folklore ads.

2. Once you've decided on
a basic structure, your
teacher will assign your
group to work on one
aspect of the site. 

3. The home page can be
developed in Publisher.
Choose Web Sites from the
Publications by Wizard
catalog, select a design,
then follow the steps to
create the home page.

4. Each group should go
back to the publications it

created in Steps B, C, and D.
Open each one, go to File, and
Save as HTML. Preview the
pages and make any needed
adjustments, then link them to
the home page according to
the overall design.

5. When your Web site is
complete, test and preview it
using Publisher and Internet
Explorer. Your teacher will
then post your site on your
school's Intranet.

STEP D
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STEP E

Storybook Rabbits
Watership Down and Tales from Watership
Down by Richard Adams. The adventures and
further adventures of a group of rabbits search-
ing for a place where they can live in peace.

The Peter Rabbit Tales by Beatrix Potter.
There are 23 stories altogether. For an online
version of one, see http://www.tcom.ohiou.edu/
books/kids/beatrix/p1.htm

The Velveteen Rabbit by Margery Williams. A
stuffed toy rabbit comes to life.

Folklore Rabbits
Myths & Fables from Around the World
http://www.afroam.org/children/myths/myths.html

Animals Myths and Legends
http://www.ozemail.com.au/~oban/

Aesop�s Fables
http://etext.lib.virginia.edu/subjects/kiddielit.html
Click on Aesop, then choose �The Lion and the
Hare� or �The Hare and the Hound�



INTERMEDIATE

NO FLAKES LIKE
SNOWFLAKES!

Few things are as awe-inspiring
as snowflakes, those miniature
masterpieces of symmetry.
This activity invites students
to explore snowflakes from the
inside by making their own.

♦ To integrate math, science,
art, and computer skills 

♦ To provide students with
experience in key concepts of
geometry, including symme-
try, angles, and scale

♦ To expose students to the
structure of snowflakes (regard-
less of weather conditions!)

♦ Basic grasp of Microsoft
Paint tool box

♦ Computer mouse skills

♦ Introduction to concepts of
symmetry, angles, and hexagons

1-2 class periods

1. Connect your computer to
an overhead projector or large
monitor so the whole class
can see. Launch Internet

Explorer, and go to the
“Snowflake” Bentley site
(http://snowflakebentley.com/) or any
other listed in the box on the
first Student Activity page.
Choose one snowflake image
to have on-screen during the
following discussion. 

2. Ask your students to brain-
storm all the attributes of
snowflakes they can think of.
For example, they might call
out "cold," "white," "lacy," and
"no two alike." Record their
suggestions on the board.  

3. Add the following
snowflake attributes to your
list, discussing each one with
your students:

♦ Snow is formed by ice crys-

tals that gather around dust
or other particles below freez-
ing. 

♦ Snowflakes are made up of
many crystals that multiply
from one seed crystal.

♦ Snowflakes look white
because of reflections off the
crystals’ many faces.

♦ Snowflakes have six sides
or six points.

♦ Most have symmetry -- verti-
cal, horizontal, or both.

♦ No two snowflakes are alike.

4. Divide your class into
pairs. Tell the pairs that they
will be using the computer to
create their own snowflakes.

REQUIRED SOFTWARE

♦ MICROSOFT® INTERNET 
EXPLORER 4.0

♦ MICROSOFT® PAINT 
(Windows 95/98 Accessory)

♦ MICROSOFT®

POWERPOINT®  97/98

SUMMARY

OBJECTIVES

HOW TO BEGIN

PREREQUISITE SKILLS

TIME ALLOTTED

Teacher Guide
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Find stunning snowflake images with Microsoft Internet Explorer 4.0.



Ever looked at a snowflake up
close? There’s a whole world of
math and science in one of
those lacy designs. Here’s your
chance to explore it firsthand.

In Search of Snow
SOFTWARE: Microsoft
Internet Explorer 4.0

WHAT TO DO: With your part-
ner, search for pictures of
snowflakes to inspire you.

1. Launch Internet Explorer,
and check out one of the Web
sites listed below. Look for
close-up shots of snowflakes
that show how they are con-
structed and how different
they are from one another.

2. When you find snowflake

pictures you like, print them
out. You can also save them
for future use by pointing to
them with your cursor and
using your right mouse but-
ton to Save As Bitmaps. 

3. Add pictures from maga-
zines and books to your
snowflake collection.

4. When you get ready to cre-
ate your own snowflakes, use
your collection to get ideas for
shapes and patterns. 

The Symmetry
Mirror
SOFTWARE: Microsoft Paint
(Windows 95/98 accessory)

WHAT TO DO: One important
fact about snowflakes is that
most of them have symmetry.
That means that if you cut a
snowflake in half, the two
halves would be exactly alike

or mirror images. Symmetry is
important in math, as a way of
understanding different
shapes. It's also important in
science, because many shapes
in nature, including
snowflakes, are symmetrical.
Symmetry is important to
artists for the same reasons.
Follow these steps to under-
stand more about symmetry. 

11..  Go to Start, choose
Programs, then Accessories,
and launch Paint. Go to the
File menu, and click on New.

2. From the toolbar, choose
the Line tool -- the one with
the diagonal line icon. (Hint:
As you hover your cursor over
each tool, its name appears.)

3. Holding down the left
mouse button, drag your cur-
sor across the screen to draw
a straight horizontal line,
dividing the screen into two
halves.

4. Have one partner on your

STEP A

DESCRIPTION

NO FLAKES LIKE SNOWFLAKES!

Student Activity
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With Microsoft Paint , make a design and create its mirror image.

STEP B

SNOWFLAKE SITES

"Snowflake" Bentley
http://snowflakebentley.com/

This Web site aims to provide a
comprehensive resource of every-
thing related to Wilson "Snowflake"
Bentley (1865-1931), an American
farmer who spent most of his life
producing photomicrographs of
snowflakes--at his Jericho, Vermont
farm. The Snow Crystal Gallery
includes 18 beautifully magnified
snow crystals.

Microscopic Snow Images
http://www.lpsi.barc.usda.gov/emus
now/

Images obtained by snow
researchers using a low tempera-
ture scanning electron microscope
at the Beltsville Agricultural
Research Center in Maryland.
Some of them even move!



team use the shape tools (rec-
tangle, ellipse, rounded rectan-
gle, or polygon) or the free-
hand tools (pencil, paintbrush)
to create a design above the
line. Your design should have
several different curves or
angles. Save the design as Sym.

5. The second partner should
select the entire above-the-line
design by choosing the Free-
Form Select tool (the button
with the the star shape), hold-
ing down the left mouse but-
ton, and drawing carefully
around the design. Go to Edit,
choose Copy, then Paste. Drag
your copied design below the
horizontal line directly
beneath the original.

6. Next, to get the mirror-
image effect of symmetry, with
your copied and pasted image
still selected, click on Image in
the menu bar, and then choose
Flip/Rotate. Select Rotate by
Angle, and click on 180. This
will rotate your image and
leave it upside-down. Depend-
ing on your design, you may
need to choose Flip/Rotate
again and click Flip Horizontal
to get a true mirror image.

7. Save your design as Sym1.
Try a few more for practice.

Make a Flake
SOFTWARE: Microsoft Paint
(Windows 95/98 accessory)

WHAT TO DO: Now that you
know a little more about sym-
metry,  put that knowledge to
work making a snowflake.

1. In Paint, open a New file.
Draw a straight line across the
middle of the page horizontally.

2. With your partner, use the
shape and drawing tools to
create one ray of a snowflake,
using your snowflake gallery
for inspiration. You might use
the polygon tool to create a
long diamond as the base of
your design. Then use the
ellipse or curved line tools to
embellish it. Use the eraser
tool to get rid of any mistakes
or extra lines you don't want.
Save your design as Snow1.

3. Next, use the Free-Form
Select tool to carefully select
your design. Holding down
your left mouse button, draw
around the design as closely as
possible without cutting into
it. Go to Edit, Copy, then Paste.
Drag the copy away from your
original design so you have
room to work on both.

4. Select your copied design
again, go to Image, and
choose Stretch/Skew. Click on
Horizontal Skew, and type in
40. Your copy will now angle
to the right at 40 degrees.
Save your work.

5. Select your copy again,

Copy and Paste it, and move it
to a different part of the
screen. Select this third ray
again, go to Image, choose
Flip/Rotate, and click Flip
Horizontal. Your third ray will
now be angled at minus 40
degrees - the mirror opposite
of the second ray. Save your
work.

6. Now  Free-Form Select and
drag each ray to bring all three
of them together as one
design. Use the Eraser tool and
the other drawing tools to fine-
tune what is now the top half
of your snowflake. Erase your
horizontal guideline as well.

7. When your half-snowflake
looks the way you'd like it,
carefully select it using Free-
Form Select, Copy and Paste it,
and move it to the bottom of
the screen. Go to Image,
choose Flip/Rotate, and Rotate
it 180 degrees as in Step 2. 

8. Move this bottom half-
snowflake into place against
the top half. Use Zoom and
the eraser to clean up any
loose or overlapping lines.

NO FLAKES LIKE SNOWFLAKES!
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STEP C

Use Microsoft Paint and symmetry to create a six-pointed snowflake. 



NO FLAKES LIKE SNOWFLAKES!

You might want to embellish
the center of your snowflake
with another design -- just
make sure it's symmetrical!
Save and print.

Start a Flurry
SOFTWARE: Microsoft Paint
(Windows 95/98 accessory)

WHAT TO DO: Okay, snow-
masters: time to try your
hands at a few more flakes. 

1. Look back through your
snowflake gallery and notice
how many different kinds of
flakes you see. Choose one
that's doesn't look at all like
the one you made in Step C.
Open a new Paint document,
and try to re-create it.

2. Experiment with different
ways to create the snowflake's
six-pointed symmetrical
design. Can you create three
long rays with identical ends,
then cross them? Could you
make two vertical halves to
join together? What happens
when you try different angles
for your skews and flips?

3. Between the two of you, cre-
ate six very different snow-
flakes you're happy with. Save
each one under a unique name.

A Cooperative
Snowstorm
SOFTWARE: Microsoft Paint
(Windows 95/98 accessory),
Microsoft PowerPoint97/98

WHAT TO DO: Now you're
going to join forces with your

classmates to create a presen-
tation about snowflakes that
acts like a snowstorm.

1. Launch PowerPoint, and
choose Blank Presentation.

2. Start with a Title slide.
Choose a background that fits
your snowstorm theme (mar-
ble is nice!), and give your
show a title like "It's Snowing
in Math Class!" 

3. Now each team can take
turns Inserting slides to show
off its best snowflakes. The
easiest way to set each page
up is to choose the blank slide
and Insert a Picture, choosing
the snowflake from the file
where all the snowflakes are
saved. Teams who want to
add text to their slide can
Insert a Text Box. Be sure to
save your presentation after
each slide is complete.

4. Next, go to View and chose
Slide Sorter. As you click on
each slide, choose a Transition

that goes with the snowstorm
idea. Checkerboard Down at
Slow speed works nicely.

5. On slides with more than
one element, you can animate
each element as well. For
example, Text could Fly from
Left, while your snowflake
Crawls from Top.

6. If you want your presenta-
tion to truly act like a snow-
storm, go to SlideShow,
choose Slide Transition, and
click Automatic, so that the
slides will advance on their
own. Try a three-second inter-
val between transitions.

7. After you've saved your
work, go back to Slide Show,
choose Set Up Show, and select
Loop Continuously. Save again.

8. Set up your classroom com-
puter where all can see it,
launch your PowerPoint file,
and go to Slide Show. Choose
View Show, and let it snow!

STEP D
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Show off snowflakes and snow facts with Microsoft PowerPoint 97/98.

STEP E



INTERMEDIATE

WEIGHTS AND MEASURES

Students learn best when they
make a personal connection
to the subject at hand. In this
activity, they become their
own raw data to analyze, com-
pare, and convert.

♦ To master the gathering,
averaging, and graphing of
data 

♦ To practice conversion to
metric measures

♦ To gain fluency in use of
technology tools for math
operations

♦ Basic introduction to
Microsoft Excel spreadsheet

♦ Exposure to metric system 

♦ Scale for measuring stu-
dents’ weight

♦ Tape measure for measuring
students' height

2-3 class periods

1. Launch Excel, open a new
workbook, and create these
headings: Name, F/M, Weight,
Height.

2. Enter each of your stu-
dents' names on a separate
row under Name.

3. Save as Class Data.

4. Position the scale and tape
measure near the computer
on which this spreadsheet is
loaded.

5. Gather students around
this computer, and explain
that each person will work

with a partner to weigh and
measure themselves, then
enter their results in Class
Data. When all the data is
complete, each student will
get a copy of the Class Data
workbook to analyze, com-
pare, graph, and convert, fol-
lowing the steps in the
Student Activity.

6. After students have com-
pleted Step A, make a copy of
the filled-out worksheet for
each student, or save it in a
common folder on your net-
work so each student can
copy it for use on his or her
own workstation.

REQUIRED SOFTWARE

♦ MICROSOFT® EXCEL 97/98

SUMMARY

OBJECTIVES

HOW TO BEGIN

PREREQUISITE SKILLS

TIME ALLOTTED

Teacher Guide
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Start by setting up a Microsoft Excel 97/98 worksheet for your class .

ADDITIONAL MATERIALS
NEEDED



Ever wonder how tall the aver-
age kid your age is? Or how
much you'd weigh in Paris?
Here you'll find the answers to
both those questions -- and
more! 

Measure It!
SOFTWARE: Microsoft Excel
97/98

WHAT TO DO:

1. Go to the computer/weights
and measures station your
teacher has set up.

2. Find your name in the Excel
workbook your teacher creat-
ed. Under F/M, type F if you're
a girl or M if you're a boy.

3. Weigh yourself on the
scale, and enter your weight
in the Weight column next to
your name.

4. Choose a partner, and
have him or her use the tape
measure to find your height
in inches. Enter this number
in your Height column.

5. Let your partner find and
enter his or her own weight.
Then measure his or her
height and enter this figure.
Save the worksheet.

Convert It!
SOFTWARE: Microsoft Excel
97/98

WHAT TO DO:

1. When everyone has
entered weight and height
data, you’ll get your own copy
of the class Excel workbook.

2. Go to cell E1 and type the
heading, Height/Feet. In cell E2,
create a formula to convert the
first student’s height in inches
to height in feet by typing
=(D2/12), which means “divide
the figure in cell D2 by 12.”
Press Enter, and double-check
the figure you see. You can now
AutoFill this same formula to
convert all the heights to feet
by clicking in cell E2, pointing
to the “handle” in its bottom
right corner, and dragging to
the end of column E. To simpli-
fy your results, click at the top

of column E, go to Cells, click
on the Number tab, choose
Number from the list, and type
1 for Decimal Places. If you get
stuck, use the Help menu.

3. Now add three more
columns: Weight in Grams,
Height in Centimeters, and
Height in Meters. Use the infor-
mation in the Metric Measures
box to create formulas that will
convert each student’s measur-
ments into these metric num-
bers. Don’t forget that “=”
starts a formula, and that
there’s usually more than one
way to solve a problem! 

4. Save and print your work.
Pair up with a classmate to
share and check results.

Average It!
SOFTWARE: Microsoft Excell
97/98

STEP A

DESCRIPTION

WEIGHTS AND MEASURES

Student Activity
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STEP C

Add columns and create formulas to convert your measurements.

STEP B

METRIC MEASURES
1 inch = 2.54 centimeters

1 foot = 1/3 of a meter, or 
0.305 meters

1 pound = 453.592 grams



WHAT TO DO: What’s the
average height and weight in
your class? Here's how to find
out.

1. In your copy of the class
Excel workbook, add a row at
the bottom of the class list. In
the Name column, type
Average.

2. In the Weight cell that shows
weight in pounds, create a for-
mula that will find the average
weight of all the students in
your class. (Remember, you
find the an average by adding
up all the values and dividing
by the number of values.)

3. Check your results to make
sure your formula is correct. If
it is, AutoFill it across the row.
Save and check your work.

Break It Down!
SOFTWARE: Microsoft Excel
97/98

WHAT TO DO: Now you'll fig-
ure out separate averages just
for boys and for girls. 

1. Select all your cells, includ-
ing your headings. Go to Data,
select Filter, and choose
AutoFilter.

2. A small box with an arrow
will appear in the lower right
hand corner of each top cell.
In the F/M column, click on
this small box, and a menu
will appear. Select F.

4. Now, the only data you'll
see is for the girls. Select all
the cells, go to Edit, and
choose Copy.

5. At the bottom left corner of
your screen, you'll see a set of
tabs marked Sheet 1, Sheet 2,

Sheet 3, and so on. Click on
Sheet 2. (If no tabs are there,
go to Insert, and choose
Worksheet.) This opens a new
"page" in your Excel workbook.

6. Click on the top left cell of
your new worksheet, go to
Edit, and select Paste. Now
you have a separate data set
for girls only.

7. Go back to Sheet 1, click on
the filter box in the F/ M col-
umn, and select (All). All class
data will reappear.

8. Now, repeat the steps
above, but choose M. Paste
your boys' data in Sheet 3.

9. In Sheet 2, add a row
labeled Average, and repeat
the procedures from Step C to
find the girls’ averages. Do the
same for the boys in Sheet 3.
Save and check your work.

Graph It!
SOFTWARE: Microsoft Excel
97/98

WHAT TO DO: Now “see" how
your class numbers chart out.

1. To graph all the heights in
your class - including the
average - select the Name col-
umn, then press Ctrl and
select the Height column. Go
to Insert and choose Chart.
The Chart Wizard will step
through creating your chart.
Click on each of the tabs and
experiment with the effect of
each option. Click on Next
when you're happy with what
you see. Click Finish, and Save
as Chart1. Save and print.

2. Now try creating a few
other charts. How about one
that compares girls' weights
to boys' weights? A chart of
all class heights in centime-
ters? One that graphs weight
and height together?

3. As a wrap-up, discuss the
kinds of data you might add
to your Excel worksheet in the
future. Maybe you want to do
the whole project again in six
months to see how much
you've all grown!

WEIGHTS AND MEASURES
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Create a graph to see at a glance how your class measures up!

STEP D

STEP E



INTERMEDIATE

DO VAMPIRES
REALLY EXIST?

Sometimes the most offbeat
subjects inspire the best math
lessons. In this activity, stu-
dents will see how math skills
and computer tools come in
handy for exploring the truly
scary subject of vampires.

♦ To identify and extend a
number pattern into very
large values 

♦ To create and interpret a
graph 

♦ To compare a math model
with real-world statistics 

♦ Basic familiarity with
Microsoft Excel 97/98, including
creating simple formulas and
using Chart features

♦ Ability to multiply numbers
by 2 (through 100)

1 class period

1. Launch Excel and set up a
new worksheet with headings
and formatting like the exam-
ple on this page. (Hint:
Double-click on the top of the

vertical line between columns
to fit column widths to your
headings.) Enter no data yet.

2. Using Internet Explorer, go
to http://www.census.gov/cgi-bin/ipc/
popclockw and add it to your
Favorites list. 

3. Gather your class together,
and ask what students know
about vampires from movies,
books, and TV shows. Kids will
probably report such facts as:
vampires only come out at
night, they sleep in coffins, they

can turn into bats, they live for-
ever, they drink blood to sur-
vive, and you become a vam-
pire if you are bitten by one.

4. Tell students that they can
now use mathematics to prove
once and for all if vampires
really exist.

5. Write the assumptions,
below, on the board. Be sure
students understand them for
the sake of the model.

6. On your worksheet, type in
the statistics for Week 0 as
shown above. With your class,
type in stats for Week 1 (1 per-
son bitten, 2 vampires at large)
and Week 2 (2 more people bit-
ten, 4 vamps on the prowl).
Tell kids they will be responsi-
ble for filling in the rest.

7. Save the worksheet, divide
your class into pairs, and have
each pair work with a copy of
the worksheet plus a photo-
copy of the Student Activity.

REQUIRED SOFTWARE

♦ MICROSOFT® EXCEL® 97/98

♦ MICROSOFT® INTERNET EXPLORER 4.0

SUMMARY

OBJECTIVES

HOW TO BEGIN

PREREQUISITE SKILLS

TIME ALLOTTED
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Teacher Guide

ASSUMPTIONS
üü One vampire does exist.
üü That vampire must suck 

one person's blood 
each week to survive.

üü Once a person is bitten 
by a vampire, he or she 
becomes a vampire.

Use Microsoft Excel 97/98 to set up your vampire math model.



Is math powerful enough to
keep vampires away? Find out
as you and your partner finish
building the spreadsheet model
your teacher started. What you
discover may be shocking!

Bites Per Week
SOFTWARE: Microsoft Excel
97/98

WHAT TO DO: Using the Excel
worksheet your class started,
work with your partner to fill
in statistics through Week 8,
using the following basic steps.

1. If there were 4 vampires at
the end of Week 2, how many
people would get bitten in
Week 3? (4) And how many
vampires would that make,
total? (8)

2. How many people would

those vampires bite in Week 4,
creating how many more of
their kind?

3. You get the idea now. Carry
it through to the end of Week
8. How many bloodsuckers do
you end up with? (256)

Graph Those
Vamps!
SOFTWARE: Microsoft Excel
97/98

WHAT TO DO:

1. Select your data in Column
C, go to Insert, and choose
Chart. Using Chart Wizard,
select a type of chart that
shows data over time. The
chart below is one example.
Click Finish.

2. Move your chart to the
right side of your worksheet,
so you can look at it side-by-
side with your data.

3. What kind of trend does
your chart show? Where might
the pattern go from here?

4. Print out your data sheet
and your chart to have on
hand for the next step.

Formula, Bloody
Formula
SOFTWARE: Microsoft Excel
97/98

WHAT TO DO: Now you're
going to get Excel to count
seven more months worth of
vampires for you -- in mere
minutes!

1. Look again at your statis-
tics through week 8. In math
terms, what is the relationship
between vampires at the end
of one week and the number
of people bitten the next? 

2. Here's another way of look-
ing at it: What pattern do you
see from week to week in the
number of people bitten?
What about the week-to-week
vampire numbers?

3. With your partner, create a
formula for Columns B and C in
Week 9 (that's cell B11 and C11,
respectively) that will extend
the pattern of Weeks 0-8. 

4. Implement your formula,
and check to be sure that the
pattern continues.

5. Now you can use Excel’s
AutoFill feature to complete
your worksheet. For Column
A, highlight cells A9 and A10,
point to the “handle” in the
lower right corner of A10, and
drag it through A37.

STEP A

DESCRIPTION

DO VAMPIRES REALLY EXIST?
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Student Activity

Create a graph to get a vivid picture of the vampire population boom.

STEP B
STEP C



6. Now fill in Column B by
using AutoFill to drag the for-
mula through week 35 (cell
B37). Fill Column C by drag-
ging the formula in C10 down
through C37.

7. Format your vampire stats
by selecting Columns B and C,
going to Format, choosing
Cells, and selecting Numbers
on the list. Type in 0 decimal
places, and select Use 1000
Separator. Save your work.

8. How many vamps are there
at the end of Week 35? If your
formulas are correct, you
should show 34,359,738,368.
Say that number out loud: 34
billion, 359 million, 738 thou-
sand, 368. That's a lot of living
dead!

Vampire Reality
Check
SOFTWARE: Microsoft
Internet Explorer 4.0,
Microsoft Excel 97/98

WHAT TO DO: So how does
your vampire census match up
against the actual world popu-
lation? Here's how to find out.

1. Launch Internet Explorer,
and go to http://www.census.gov/
cgi-bin/ipc/popclockw, the U.S.
Census Bureau's World
POPClock. (Your teacher may
have already added it to
Favorites in Explorer.) This
gives an up-to-the-second pro-
jected count of the world's
human population, based on
actual numbers plus estimat-
ed births and deaths.

2. What number is showing in
bold type? It should be about
six billion, give or take a few
million. Select this number, go
back to your Excel worksheet,

and paste it into cell C38.

3. In cell D38, type in the
label People on Earth.

4. Save and print your sheet.

5. Reconvene as a class to dis-
cuss your findings. According
to your mathematical model,
how many of the world's peo-
ple are actually vampires?
(Every single one of them --
and then some!) At which
point in your chart did the
entire population of Planet
Earth become vampirized?
(Between Weeks 32 and 33.)
Could this possibly be true?
Congrats! You have just con-
structed what mathematicians
call a "proof by contradiction." 

6. Just for fun, copy your data
sheet, paste it in a new work-
sheet, and start with three
vampires instead of just one.
Enter values manually for the
first few weeks, then create a
formula to extend the pattern.
How long does it take vam-
pires to take over the world in
this scenario?

DO VAMPIRES REALLY EXIST?
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Check your worldwide vampire census against the real thing. 

STEP D

SCARY-NET: SPOOKY
STUFF ON THE WEB

Once you�ve done your vampire
math, use Internet Explorer to
check out these thrills and chills.

Halloween Eternal
http://home.rmci.net/gatemi/
It�s all Halloween, all the time on
this activity-filled site.

Haunted Halloween
http://www.banzai-net.com/haunted
_hofp/
This online magazine includes
Halloween humor. 

Halloween Net
http://www.halloweennet.com/
Haunting tips and tricks, ghost
stories, even scary foods for the
holidays!

The Yuckiest Site on the Internet
http://www.yucky.com/yucky/
Gross science, including worms,
bugs, and more.



MIDDLE SCHOOL

EXTREME
WEATHER!

From El Nino to killer heat
waves, weather extremes cap-
ture headlines and the popular
imagination. This science and
geography activity builds on
kids' natural fascination with
weather disasters.

♦ To develop students' under-
standing of basic meteorology
and related earth science top-
ics 

♦ To reinforce geographical
knowledge

♦ To build analytical and com-
munications skills through
class presentations

♦ Basic understanding of how
weather works

♦ Intermediate electronic
research skills using tools like
Microsoft Encarta 98/99
Encyclopedia Deluxe and
Microsoft Internet Explorer 4.0

♦ Fundamentals of Microsoft
Word 97/98 and Microsoft
FrontPage 98

3-5 class periods

1. Start with a class discus-
sion of weather extremes stu-
dents have experienced per-
sonally. Ask your class: If a sci-
ence reporter were to inter-
view you about the worst
weather you've ever wit-
nessed, what would you say?
What made that weather so
remarkable?

2. Next, brainstorm a list of
other kinds of extreme weath-
er. Encourage students to think
of as many examples as they
can, from storms they've heard
about on the news to events
they remember from history. 

3. If kids include events such
as earthquakes or volcanoes
on the list, go back when your
brainstorming is over and ask
them to think carefully about
whether these disasters really
fall under the heading of
"weather." Together, develop a

working definition of weather
that includes the concept of
the atmosphere and the
impact of such factors as tem-
perature, humidity, cloudi-
ness, precipitation, wind, and
pressure. Direct students
toward an understanding that
extreme weather, then,
involves one or more of these
factors occurring with unusu-
al force or quantity. 

4. Have each student choose
the three most personally fas-
cinating forms of extreme
weather and list them on a
sheet of paper. Collect the
papers and divide your class
into teams of three or four,
according to weather choices.

5. Explain that each group
will now become a crack team
of meteorologists with special
expertise in tracking, analyz-
ing, and explaining its chosen
weather extreme via a Web
page for whole-class viewing.

REQUIRED SOFTWARE

♦ MICROSOFT® ENCARTA® 98/99
ENCYCLOPEDIA DELUXE

♦ MICROSOFT® INTERNET 
EXPLORER 4.0

♦ MICROSOFT® WORD 97/98

♦ MICROSOFT® FRONTPAGE 98

OPTIONAL SOFTWARE

♦ MICROSOFT® ENCARTA® 98/99 
VIRTUAL GLOBE (Windows only)

SUMMARY

OBJECTIVES
HOW TO BEGIN

PREREQUISITE SKILLS

TIME ALLOTTED

Teacher Guide
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Your students will research exciting weather sites on the Internet.



Here is your mission: To figure
out what makes extreme weath-
er act the way it does, find the
most awesome examples of its
power, and then create a Web
page to explain it all to your
classmates.  Ready to take the
weather world by storm? 

A Storm is Born
SOFTWARE: Microsoft
Encarta 98/99 Encyclopedia
Deluxe, Microsoft Internet
Explorer 4.0, Microsoft Word
97/98

WHAT TO DO: Get to the
heart of your weather extreme.

1. Launch Word, open a New
document, and type in the
heading "Causes of [Your
Storm].” Save the Word docu-
ment with a file name related
to your kind of storm.

2. Launch  Encarta Encyclo-
pedia, go to Encyclopedia
Articles, and use the Pin-
pointer to find your weather.  

3. As you read through the
articles you find, look for
explanations of what causes
your extreme weather. Copy
new facts you find -- along with
any graphics or photos -- and
paste them in your Word docu-
ment.

4. From within your Encarta
Encyclopedia article, click on
the More Information About
This Subject icon in the top
right corner of your screen.
Choose Web Links, and
explore the Internet for more
information about your kind of
storm. (You can also try some
of the sites listed in the box on
this page.) When you find new
facts, copy and paste them in
your Word document.

5. Look for pictures, diagrams,
and other images to help

explain your extreme weather.
Save these images by clicking
your right mouse button,
choosing Copy, then pasting
them in your Word document.
Keep track of your sources! 

6. Add the best sites to your
Favorites folder.

7. Discuss your findings as a
group. Then, in your Word doc-
ument, click on View, go to
Toolbar, and choose Drawing.
Use these tools to sketch a dia-
gram showing how your storm
works. Use Help if you need it.

Map the Zone
OPTIONAL SOFTWARE:
Microsoft Encarta Virtual
Globe 98/99 (Windows only)

WHAT TO DO: If you have
Encarta Virtual Globe, use this
optional step to find out more
about the geography of your
killer weather.

STEP A

DESCRIPTION

EXTREME WEATHER!

Student Activity
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Open a 
Microsoft Word
97/98 document
to collect and 
organize the
facts, photos,
and graphics 
you find in
Microsoft
Encarta 98/99
Encyclopedia
Deluxe and on
the Internet 
about your 
chosen weather
extreme.

STEP B

WEATHER SITES

The Weather Channel
http://www.weather.com/education/

National Weather Service
http://www.nws.noaa.gov/

University of Michigan Weather
Underground 
http://groundhog.sprl.umich.edu/

Weather World 2010
http://ww2010.atmos.uiuc.edu/(Gh)/
home.rxml

Memorable Weather Events
http://ww2010.atmos.uiuc.edu/(Gh)/
arch/cases/home.rxml



1. Launch Virtual Globe, click
on Learn About the Earth, and
scroll down to The Physical
World. If your weather fits the
general category of Monsoons,
Tropical Storms, and
Tornadoes, go to that article
for lots of facts and maps.
Otherwise, read through
Seasons: Climate, Stars, and
Earth Changes. Copy pertinent
facts for your Word file under a
heading called “Weather Zone.”

2. Go to Map Styles on the
Toolbar, choose Natural, and
check out the Climate, Eco-
region, and Temperature maps
of your storm hot zones. Use
the About This Map feature to
interpret the data you’re seeing. 

3. When you find maps you
want to keep, go to Options
and choose Copy. You can
then paste your maps into
your Word file.

One For the
Record Books
SOFTWARE: Microsoft
Encarta 98/99 Encyclopedia
Deluxe, Microsoft Internet
Explorer 4.0, Microsoft Word
97/98

WHAT TO DO:

1. Go back to Encarta and
Favorite Web sites to look for
"worst ever" occurrences of
your extreme weather. You
may discover that "worst" has
many meanings. Is the worst
blizzard the one with the most
snow, the highest winds, or the
longest duration? In your Word
document, set up a new head-
ing called "Record-Breakers" to
save these facts. 

2. Pick one record storm to
explore further. Search the
Web for articles reporting on
the storm as it happened.

Stormy Webber
SOFTWARE: Microsoft Word
97/98, Microsoft FrontPage 98

WHAT TO DO: Pull all of your
work together as a Web page.

1. Open your Word file.
Organize the facts you’ve
gathered (you might find the
Outline option in the View
menu helpful for this). Rewrite
the material in your own
words, as though you were
were explaining it to a friend.

2. When your editing work is
complete, go to the File menu,
and choose Save As HTML. 

3. Launch FrontPage, choose
New FrontPage Web, and click
on One-Page Web. Name your
web after your storm.

4. When the Navigation screen
appears, click on Themes to

choose a color scheme, font,
and button style. Click Apply.

5. In the File menu, choose
Import. Find the HTML file you
created from Word, and import
it. This page will now appear in
the list of files on your Web. 

6. Go to File and Open your
home page. Choose Insert,
select File, and choose your
Word HTML file. The text will
flow into your home page.

7. Add a Heading at the top of
your home page, and smaller
Headings for each subtopic
(such as Causes, Zones, and
Record-Breakers). Insert a
Navigation bar to link your
subtopics. Experiment with
Animation effects from the
Format menu, and Insert some
Active Elements such as a
Marquee of fun storm facts. 

8. When your Web is com-
plete, invite your classmates
to test it out. Then work with
the other teams to create one
big Weather Web. Publish it to
your school intranet. 

EXTREME WEATHER!
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STEP C

Use Microsoft FrontPage 98 to turn your facts into a Web page.

STEP D



MIDDLE SCHOOL/
HIGH SCHOOL

OUR BRILLIANT
CAREERS

Whether your students are
geared up for the world of work
or just beginning to think about
careers, this activity will open
their eyes to the possibilities.

♦ To introduce students to
possible future careers

♦ To encourage groundwork
for future career choices  

♦ To explore emerging careers  

♦ Basic research skills using
Microsoft Internet Explorer 4.0

♦ Introduction to Microsoft
Access 97/98

2-3 class periods and ongoing

1. Prepare the database by
launching Access and choosing
Blank database. When prompt-
ed, save the database as
Careers. 

2. Click on the Tables tab, and
then click New. Choose Table
Wizard and click OK. Under
Sample Tables, choose
Employees. From the sample
fields, choose FirstName and
click the single right arrow to
add it to your table. Repeat with
the following fields, in this
order: Title, DepartmentName,
OfficeLocation, Salary, Address,
Notes, and EmailName. 

3. Select DepartmentName and
click Rename Field. Rename as
Type of Company, and click
OK. Repeat this process to
change OfficeLocation to Work
Environment, Address to
Education Requirements, and
EmailName to Web Links. Click
Next.

4. On the next screen, save
your table as CareerTable, and
select "No, I'll set the primary
key." Click Next, and choose
FirstName as your Primary
Key, and then select "Numbers
and/or letters I enter when I
add new records." 

5. Click Next, and choose
"Enter data into a table using a
form the wizard creates for
me." Click Finish. A blank data
form will appear on the screen.

6. Using a projector or large
monitor, present the data form
to your students. Explain that
they will spend the next few
class periods finding out about
careers that interest them and
entering information into the
class database. Each student
will do at least three records,
and then all will search and
analyze the data together.

7. First, though, the class will
collaborate on the final design
for your database. With the
blank data record showing, go
to View and choose Design
View. Click on Format, and
choose AutoFormat. Preview
each format and choose one
together. Choose View, and go
back to Form View. Print out a
blank record, then close the
Form. Photocopy the blank
record and hand out with the
Student Activity pages.

REQUIRED SOFTWARE

♦ MICROSOFT® ACCESS 97/98

♦ MICROSOFT® INTERNET EXPLORER 4.0

SUMMARY

OBJECTIVES

HOW TO BEGIN

PREREQUISITE SKILLS

TIME ALLOTTED
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Teacher Guide

Use field names like these to set up a Microsoft Access 97/98 careers database for your students.



Remember back when you had
an easy answer for the ques-
tion, "What do you want to be
when you grow up?" In this
activity, you'll  focus in on three
or more careers you might real-
ly want to pursue -- including
one that doesn’t quite exist yet!

Browse the
Possibilities
SOFTWARE: Microsoft
Internet Explorer 4.0,
Microsoft Access 97/98

WHAT TO DO: Some students
your age have an inkling of
what they might want to do for
a career -- but not all do. And
even those who are fairly cer-
tain should keep this in mind:
Experts predict that in the
future most people will change

careers more than five times in
the course of their working
life. It pays to have a few possi-
bilities to choose from!

1. Use Internet Explorer to
check out some of the Web
sites listed on this page, many
of which include information
about specific kinds of careers.
Browse through the headings
and job titles, and choose at
least two that appeal to you.

2. Explore these career possi-
bilities in depth, keeping in
mind the kinds of information
you'll need for your class data-
base. You'll want to know the
kind of company this job might
be part of, what the work envi-
ronment is like (such as in an
office or outdoors, formal or
relaxed), what the salary range
is, and what kind of education
and/or training is required. In
addition to the information you
find in career sites, you might
check out Web sites for profes-
sional associations, online arti-
cles about people in this field,
and actual job listings from
around the country. Print out

the best information you find,
and keep track of your sources.

3. Launch the Access database
you created as a class. Click the
Forms tab, and choose the
form you created together. If
you are the first to use the
database, you will see a blank
record. Otherwise, go to Insert,
and choose New Record. (You
can also click the right arrow
with star in the bottom left cor-
ner.) Fill in one new record for
the first career you've explored.
Enter your name with a 1 after
it in the FirstName field. Repeat
for your other careers, using a
2 after your name, then a 3, and
so on. Review your records by
clicking the left and right
arrows in the bottom left cor-
ner of the screen. Save your
work.

Jobs of the Future
SOFTWARE: Microsoft
Internet Explorer 4.0,
Microsoft Access 97/98

STEP A

DESCRIPTION

OUR BRILLIANT CAREERS
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Student Activity

STEP B

WORK IT OUT
Bureau of Labor Statistics-
Occupational Outlooks
http://stats.bls.gov/ocohome.htm
Official statistics about the job mar-
ket and occupational trends.

JobSmart
http://jobsmart.org/
Lively career guides (including hot
jobs) and salary information.

StudentCenter/AboutWork
http://www.aboutwork.com
Careers and what they�re really
like, plus reviews of job Web sites.

Career Mosaic
http://www.careermosaic.com/
Includes Career Resource Center
with job trends and tips.

Fill in a Microsoft Access 97/98 data record for each career choice.



WHAT TO DO: By the time
you're ready for your first
career, who knows what new
opportunities you might have
that aren't yet a glimmer in a
career counselor's eye?

1. Several of the Web sites
you visited have information
about future job market
trends and emerging careers.
Go back and check these out.
See anything that interests
you? Find out all you can
about these jobs-to-be.

2. Think about trends that are
changing people's lives: the
amazing growth of the
Internet, say, or the aging of
the Baby Boom generation.
Then think about the number
of times you've said, "I wish
someone would figure out a
way to…" Produce jeans that
really fit you, for a reasonable
price? Let you get around town
quickly without a car? Make
sure everyone has a decent
place to live?  Think about the
kinds of jobs that might spring
up to meet those needs.

3. Since your future jobs don't
yet have salary ranges or edu-
cational requirements, you'll
need to make some guesses.
Start with the kind of training
the job might entail, and how

many people would need its
services. Generally, the harder
the training and the more in
demand the work that's pro-
duced, the higher the salary. 

4. Now enter your future
job(s) in the Access database.
Include an (F) after the job
title. In the Notes field, explain
what this job will be all about
and why it’s intriguing.

Mine Your Data
SOFTWARE: Microsoft
Access 97/98

WHAT TO DO: Once everyone
in class has entered at least
three job records, explore
your Careers database.

1. Open your database, click
the Forms tab, and select your
class form.

2. If you have a particular job
you're interested in, click on
the Title field in the first
record you see. Go to Edit,
choose Find, and type in a
keyword; in the match crite-
ria, choose Any Part of Field
for the widest return. Click
Find First. If more than one
record is retrieved, you can

click Find Next to view each
one. Print out at least one
record that interests you.

3. If you'd rather just browse,
click on the Title field, go to
the Toolbar, and click AZ. Now
all the records are arranged
alphabetically by title. Use the
arrows at the bottom left to
step through the database.
Print one or more records.
(You can also get an at-a-
glance view of all the records
by closing the Form, selecting
the Tables tab, and opening
your CareerTable. Select any
column by clicking at the top,
and use the AZ or ZA buttons
on the Toolbar to arrange the
data. You can also go to Edit,
choose Find, and search for a
keyword. A small arrow will
appear to the left of each
match.)

4. Think about other job crite-
ria that are important to you.
Are you looking for the highest
salary? In either Table or Form
view, select the Salary field, go
to the Toolbar, and click ZA.
The records are now arranged
with the highest salaries first.
Do you want to work out-
doors? Select the Work
Environment field, go to Edit,
choose Find, and use “out-
doors” as your match criteria. 

5. Talk to the students whose
entries you've selected to find
out more about these careers.

6. Finally, choose three
careers -- one you researched
originally, one you've learned
about from another student,
and one from the future -- and
give an oral report to the
class about them. Invite sug-
gestions for other jobs you
might like.

OUR BRILLIANT CAREERS
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Get an at-a-glance view of careers by sorting in Table format.

STEP C



MIDDLE SCHOOL/
HIGH SCHOOL

THE ART AND SCIENCE
OF FRACTALS

This activity introduces stu-
dents to the fascinating world
of fractal images and the
mathematics behind them.
Students will be exposed to
fractal geometry, history and
concepts, explore fractal sites
on the Web, create their own
fractal designs, and publish a
calendar that displays their
favorite fractal art.

♦ To stimulate students’ inter-
est in fractal geometry and
related fields

♦ To develop students’ aware-
ness of connections between
art, mathematics, and nature

♦ To allow students to pub-
lish calendars that reflect
their work and creativity 

♦ Basic knowledge of Microsoft
Encarta 98/99 Encyclopedia
Deluxe and Microsoft Publisher 98

♦ Web navigation with
Microsoft Internet Explorer 4.0

♦ Exposure to fundamental
concepts of middle school
math and geometry

Approximately 2-3 class 
periods

1. Ask the students if they
have ever noticed the realistic
landscapes, such as craggy
mountain ranges, in some 3D
computer games.  Ask if they
have ever wondered how those
landscapes were created. 

2. Introduce the concept of
fractals as a mathematical way

of modeling real world fea-
tures, a method used to create
realistic virtual realities and
stunning digital art.

3. Tell students that they will
be using Encarta Encyclopedia
and Internet Explorer to learn
more about fractals and see
examples of fractal art.

4. Tell students that they will
be able to capture and publish
their favorite images in a cal-
endar they will create with
Publisher.

REQUIRED SOFTWARE

♦ MICROSOFT® ENCARTA® 98/99
ENCYCLOPEDIA DELUXE

♦ MICROSOFT® INTERNET EXPLORER 4.0

♦ MICROSOFT® PUBLISHER 98

SUMMARY

OBJECTIVES

HOW TO BEGIN
PREREQUISITE SKILLS

TIME ALLOTTED

Teacher Guide

Fire and Ice , from the fractal art gallery of Uwe Krueger and Heinz Wolf.
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In this activity, you'll team up
with a classmate to investigate
the world of fractal geometry.
You'll learn what fractals are,
discover how they relate to
the natural world, and get an
introduction to the mathemati-
cal principles behind them.
Then you'll explore fractal Web
sites, tour online fractal art
galleries, and publish your
favorite fractal image as calen-
dar art to share with your fam-
ily, friends and classmates.  

Get the Big Picture
SOFTWARE: Microsoft
Encarta 98/99 Encyclopedia
Deluxe, Microsoft Internet
Explorer 4.0

WHAT TO DO: Team up with a
classmate, then:

1. Open Encarta Encyclopedia
and click Encyclopedia
Articles in the opening screen.
Click Find in the menu bar to
open the Pinpointer. Type
Fractal in the search box to
locate the Fractal article in

the title list, then click on it to
go to the Fractal article. Read
the text and explore the inter-
active exercises and the
snowflake example. 

2. When you're done, check
your understanding by defining
“fractal” for your partner in
your own words. Discuss self-
similarity and infinite complexi-
ty as they relate to fractals.

3. List at least 3 examples of
natural structures that can be
modeled with fractal geometry.

Make a Famous
Fractal
SOFTWARE: You don�t need
any! But you will need trian-
gular gridpaper.

WHAT TO DO: You don’t need
a supercomputer to make a
fractal - just paper and pencil.
We’re going to make a famous
fractal called the Sierpinski
Triangle in several increasing-
ly complex versions, or itera-
tions, to illustrate how a frac-
tal can be represented at vari-
ous levels of complexity.
(Special thanks to Cynthia
Lanius at Rice University for
permission to include this
exercise, ©1996-1998 Cynthia
Lanius.)

1. Draw an equilateral triangle
with sides of 2 triangle units
each. Connect the midpoints
of each side. How many equi-

STEP A

DESCRIPTION

Student Activity

Microsoft Encarta 98/99 Encyclopedia gives you the facts on fractals.

STEP B

FRACTAL FACTS
Fractals are geometric shapes that are complex and detailed in structure at
every level of magnification.

Fractals exhibit the following characteristics:
1) Self-similarity - Each small part of a fractal is a reduced replica of the whole.
2) Fractional dimension - The dimension of a fractal must be used as an 

exponent when measuring its size.
3) Formation by iteration - Fractals can be formed by applying a single opera-

tion that increases complexity (such as bisecting a line) over and over again.

Though based on abstract mathematics, fractals have practical applications in
computer graphics, digital imaging, and modeling complex natural structures.

THE ART AND SCIENCE OF FRACTALS
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THE ART AND SCIENCE OF FRACTALS

lateral triangles do you now
have? Shade out the center tri-
angle.

2. Draw an equilateral triangle
with sides of 4 triangle units
each. Connect the midpoints of
the sides and shade the trian-
gle in the center as before.
Notice the three small trian-
gles that also need to be shad-
ed out in each of the three tri-
angles on each corner. 

3. Draw an equilateral trian-
gle with sides of 8 triangle
units each. Follow the same
procedure as before, making
sure to follow the shading pat-
tern. You will have 1 large, 3
medium, and 9 small triangles
shaded. Use your artistic cre-
ativity and shade the triangles
in interesting color patterns.

4. Combine your triangle cre-
ated in step 3 with those cre-
ated by other teams to form a
larger Sierpinski Triangle for
display in the classroom.  

Take a Closer Look
SOFTWARE: Microsoft
Encarta 98/99 Encyclopedia
Deluxe, Microsoft Internet
Explorer 4.0

WHAT TO DO:

1. Follow links from the
Encarta Encyclopedia article or
the list on this page (using
Internet Explorer) to explore
fractal sites on the Web.  

2. For a “hands on” demon-
stration, try the interactive
demo in the Encarta
Encyclopedia article. Or visit
the fractal microscope
(http://www.ncsa.uiuc.edu/Edu/Fractal/

Fractal_Home.html) or animated
fractals (http://www.mth.uea.ac.uk/
mpeg.html) Web sites. Notice
how detail emerges at each
level of magnification.  

3. Save images you like by plac-
ing the mouse pointer on them,
clicking the right mouse button,
and selecting Save Picture As
from the popup menu. Name

the pictures and save them to a
diskette or hard drive.

Create a Fractal
Calendar
SOFTWARE: Microsoft

Publisher 98

STEP C

The iteration of the Sierpinski Triangle can be repeated indefinitely to
create increasingly complex fractal images.

STEP D

FRACTAL WEB SITES TO CHECK OUT
http://www.shodor.org/master/fractal/ - Links to an introduction to fractals
and to a fractal microscope that lets you �zoom in� on infinite complexity!

http://math.rice.edu/~lanius/frac - An easy-to-follow discussion of fractals
designed for students, including examples, explanations and related links.

http://aleph0.clarku.edu/~djoyce/julia/explorer.html - An interactive site that
lets you create your own fractal images.

http://fas.sfu.ca/0/cs/research/projects/FractalCal/cal.html - A collection of
fractal calendars with detailed descriptions of how the images were created.

http://www.fractals.com/fractal_gallery/uwe_krueger/room1.html - The
mother of all online fractal art galleries. Stunning images; BIG downloads.

http://www.mth.uea.ac.uk/mpeg.html - Really cool animated fractals!

http://life.csu.edu.au/complex/tutorials/tutorial3.html - All the fractal math
you ever wanted, plus great links to other fractal sites.
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WHAT TO DO: Select your
favorite image from the fractal
art you downloaded from the
Web to publish as your calen-
dar art. Here's how: 

1. Launch Publisher. Click the
Publications by Wizard tab,
then click Calendars.

2. Select one of the Full Page
Calendar templates that pro-
vides space to insert your
own graphic. Art Left
Calendar and Art Right
Calendar are good choices.

3. When the Calendar Wizard
appears, click Next to begin
the process of customizing
your calendar.

4. Choose a color scheme
that will complement the col-
ors of the fractal image you've
chosen. 

5. Select Portrait orientation
to give your image more room
at the top of the page. 

6. Select Yearly so that your
calendar will span twelve
months. 

7. Click the Change Dates but-
ton to change the year your
calendar spans (January to
December 1999, for example). 

8. Click Finish when you’re
done. Then choose Hide
Wizard from the View menu to
give yourself more room to
work.

9. Insert the fractal image
you've chosen in a picture box
at the top of the calendar.

Note: The text and picture
boxes may be grouped. To
alter or delete them separate-
ly, you will need to select
Ungroup Objects from the
Arrange menu.

♦ Select the existing picture
box, or create a new one. 

♦ Select Picture/From File…
from the Insert menu to locate
your saved fractal file and
insert it into the picture box.

♦ Restore the image's original
colors, if necessary, by select-
ing the image and then select-
ing Recolor Picture/Restore
Original Colors from the
Format menu.

10. Be sure to credit the
source of your fractal in a text
box beneath the image.

11. Save your work. Print
copies to share with your
classmates, friends and family!

THE ART AND SCIENCE OF FRACTALS

Use Publisher to create a calendar that displays your favorite fractal art.

Genesis , from the online fractal gallery of Uwe Krueger and Heinz Wolf. 
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HIGH SCHOOL

LITERARY
SCAVENGER HUNT

The classics of English litera-
ture have been read, discussed
and analyzed by generations of
American school kids. But that
doesn't mean that learning
about them can't be a fresh
and fun experience for today's
students. In this activity, stu-
dents learn about literature in
a new way by searching the
Web in a scavenger hunt for
information about books and
authors. Fact gathering is just
half the fun, though. When the
hunt is over, students will pub-
lish their answers in an inter-
active slide show for presenta-
tion to the class.

♦ To stimulate student inter-
est in learning about literature 

♦ To develop students' confi-
dence and resourcefulness in
searching the Web 

♦ To allow students to answer
questions and solve problems
creatively and interactively 

♦ Knowledge of literature
appropriate for grade level
and scavenger hunt questions

♦ Experience browsing and
searching the Web 

♦ Fundamentals of Microsoft
Internet Explorer 4.0, Microsoft
Word 97/98, and Microsoft
PowerPoint 97/98

2-3 class periods

1. Before class, you'll need to
develop a list of questions for
the scavenger hunt. Sample
questions are provided in the
student activity section, but
you might want to modify this
list to reflect your particular
curriculum. If so, here are a
few guidelines: 

♦ Clear, concise questions
with brief answers are best for
this activity. 

♦ Questions can pertain to lit-
erature that the students 
have already encountered 

in the classroom, but should
also introduce new material. 

♦ Make sure that the answers
can be found in the available
sources.

2. For the scavenger hunt,
group the students in teams of
two. Give each team a set of
the Student Activity pages and
the list of questions. Set a
deadline for the hunt itself
(such as one class period), and
tell the students that they will
have additional time to create
their PowerPoint shows.

3. Inform students that each
team will have the opportuni-
ty to present their finished
PowerPoint presentation to
the class. Students will then
vote to decide the winning
team. Remind the students
that they should base their
vote on content as well as
design of the presentations. 

REQUIRED SOFTWARE

♦ MICROSOFT® WORD 97/98

♦ MICROSOFT® INTERNET 
EXPLORER 4.0

♦ MICROSOFT® POWERPOINT 
97/98

SUMMARY

OBJECTIVES HOW TO BEGIN

PREREQUISITE SKILLS

TIME ALLOTTED

Teacher Guide
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Scavenging on the Web can be rewarding - if you know how to search.



If "classic literature" makes
you think of dusty old books,
think again. How about word-
searchable Web sites and
hypertext? In this activity, you
and a classmate will team up
in a literary scavenger hunt
on the Web. Then you'll pre-
sent your findings in the form
of an interactive slide show. 

Stalk Your
Quarry
SOFTWARE: Microsoft Word

97/98, Microsoft Internet

Explorer 4.0

WHAT TO DO: You have your
questions...now track down the
answers! Carefully formatting
your questions and answers in
Word will make it a lot easier to
create your slide show later. 

1. In Word, type a neat list of
all your scavenger hunt ques-
tions, with paragraph returns
and no blank lines between
them. (Don’t number the ques-
tions - you can do that later in
PowerPoint.) Save this docu-
ment. You’ll use it for the table
of contents in your slide show. 

2. Create a separate document
to collect your answers. Start
by copying your question list
into this document. As you find
your answers, enter them as
paragraphs directly beneath the
questions, with no blank lines in
between. At the end of each
answer, include the full URL of
the location where you found it.

3. Indent your answer para-
graphs by clicking on each
one and then clicking the
Increase Indent button in the
Formatting Toolbar. When
you’re done, your questions
should be flush left, your
answers indented, and all
your text should be Normal
style (as indicated in the
Formatting Toolbar).

4. Start your search at the
Web sites listed on this page.
Be alert: You may run across
the answer to one question
while looking for another.

5. Keep your answers brief -
no more than a few sentences.

Show Off Your
Catch
SOFTWARE: Microsoft Word
97/98, Microsoft PowerPoint
97/98 

WHAT TO DO: Now you’ll 
convert your questions and
answers into a PowerPoint
presentation.

1. Open your Word document.
From the File menu, choose
Send To and select Microsoft
PowerPoint. 

2. PowerPoint opens, display-
ing your newly created slide
presentation in Outline view.
Select Slide in the View menu
and look at your slides. Each
slide should have a question in
the title box at the top and the
corresponding answer in the
text box below. Adjust font
size and text box dimensions,
where necessary, to make
questions and answers fit. 

3. From the Format menu,
select Apply Design. Select a
design you like and click OK.
(You can repeat this later to
change the design, if you want

STEP A

DESCRIPTION

LITERARY SCAVENGER HUNT

Student Activity
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STEP B

SITES TO CHECK OUT
American Literature Online - a
chronological list of links to
authors, books and topics in
American literature: http://www.
missouri.edu/%7Eengmo/amlit.html

University of Delaware Library
Guide to English and American
Literature - more great links:
http://www2.lib.udel.edu/subj/engl
/internet.htm

Library of Congress - search the
stacks by subject, title, or author: 
http://lcweb.loc.gov/homepage/lchp.
html

SAMPLE QUESTIONS FOR THE HUNT
1. Name two novels by Ernest Hemingway. When were they were published?
2. Who wrote Travels with Charlie? Describe Charlie.
3. Define the "American dream" and give an example from a novel you�ve read.
4. Who wrote The Lord of the Flies? Briefly describe the setting and theme.
5. What do the protagonists in The Scarlet Letter and Fahrenheit 451 have in

common?
6. What is the nature of the conflict in To Kill A Mockingbird?
7. Who wrote 1984? What is the protagonist's greatest fear?
8. Name two plays by Arthur Miller. Give a one-sentence description of each.
9. Where does a symbol of God appear in The Great Gatsby?
10. Name a nature writer from the school of American Romanticism.



to.) To make additional color
changes, you can select
Background and Slide Color
Scheme from the Format menu.

4. Try animating your answers.
Select Slide in the View menu,
and click on the answer text in
slide 1. From the Slide Show
menu, select a Preset Animation
option. Preview your animation
by selecting View Show from
the Slide Show menu. 

5. Now animate all your slides.
You can even use different ani-
mation options on each slide!

Make It
Interactive
SOFTWARE: Microsoft Word
97/98, Microsoft PowerPoint
97/98

WHAT TO DO:

1. First create a few slides for
your interactive Table of
Contents. Choose New Slide
from the Insert menu. The New
Slide dialog box appears. Select
the Bulleted List AutoLayout

and click OK. A new blank slide
will be added to your presenta-
tion. Repeat this process to
create two or three new slides.
With either Outline or Slide
Sorter selected in View, drag
your new blank slides to the
beginning of your show. 

2. Go to your first slide in
Slide view. Click in the title box
and type a title for your show.

3. Now go to your Word docu-
ment that listed the questions
only. Copy the list and Paste it
into the text box on slide 1. 

4. The list of questions will
probably be too long to fit on
one slide. Cut the remaining
questions from the bottom of
the list and paste them into
the text box on the second
slide. Repeat this process to
accommodate all the scav-
enger hunt questions. Print a
Handout version of your slide
show (6 slides per page) to
refer to for the following steps.

5. Now you can add a button
next to each question in the
table of contents that will link
directly to the chosen slide.  

♦ Go to the beginning of your
show and select Slide in the
View menu. Select Action
Buttons in the Slide Show
menu, and choose the Custom
(blank) button. The mouse
pointer becomes a crosshair
with which you can draw a
button next to a question in
the table of contents. 

♦ When you are finished draw-
ing your button, the Action
Settings dialog box opens. On
the Mouse Click tab, choose
Hypertext link to slide, and
select the slide that corre-
sponds to the question you are
linking. Click OK to close the
Action Settings box. To test
your link, switch to Slide Show
mode (in the View menu). 

♦ Repeat this process for all of
the questions in your table of
contents. 

6. Add three more navigation
buttons to each slide: 

♦ A Home button for jumping
back to the table of contents
from anywhere in the show. 

♦ Previous and Next buttons
to let you move forward or
backward through the show.

♦ To place these buttons on
every slide, select Master, Slide
Master from the View menu.
Select the Home, Previous and
Next buttons from the Action
Button choices. Place them at
the very bottom of the Slide
Master so they won’t overlap
your text boxes.  When you're
done, test them by selecting
View Show in the Slide Show
menu.

7. Now you can present your
scavenger hunt results in an
exciting, fully interactive
PowerPoint show. Present it to
your class with pride!

LITERARY SCAVENGER HUNT
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STEP C

Action Buttons make it easy to navigate through your PowerPoint show.



HIGH SCHOOL

DESERT STORM,
REVISITED

Although the Persian Gulf War
unfolded less than 10 years
ago, it may be ancient history -
or even lost history - for your
students. This activity will
bring the war into focus for
today's young people, while
building on their distance from
the conflict with an objective
debate about its merits.

♦ To help students develop an
understanding of the Persian
Gulf War as an example of late
20th century world conflicts 

♦ To challenge students to 
consider the pros and cons of
America's role in "Desert Storm"  

♦ To provide students an
opportunity to present a for-
mal debate on a topical issue 

♦ Research skills using
Microsoft Encarta 98/99
Encyclopedia Deluxe and
Microsoft Internet Explorer 4.0

♦ Ability to develop a Microsoft
PowerPoint 97/98 presentation -
including maps, charts, and pho-
tos - as a visual aid to a debate 

3 class periods

1. Create a classroom library
of print materials, videos, and
other non-computer resources
focusing on the Gulf War. If
you know anyone who served
in the armed forces during the
war, or who played some
other significant role, you
might arrange to have them
visit your class.

2. Ask students to think about
where they were and what they
were doing in fall of 1990 and
spring of 1991. Ask them what
they remember about the
Persian Gulf War, also known in
America as Operation Desert
Storm. Students may recall
hearing about Saddam Hussein
or General Colin Powell for the
first time, or they might remem-
ber seeing the bombing of
Baghdad on television. Record
their memories on the board.

3. As a follow-up question,
ask students what they think
the consequences of the war
have been, including any last-
ing effects they see today.

4. Now pose this challenge to
your students: Imagine you
have traveled back in time to
serve as youth advisers to
President George Bush. To
give him the advice he needs,
you have to understand the
facts - and then take a strong
position. You'll develop both
by staging a series of debates.

5. Divide your class in half,
randomly. Designate one half as
pro, the other as con. Within
each half, have students form
debate teams of 3 or 4 mem-
bers each. Set a date for your
debates, hand out the Student
Activity pages, and remind stu-
dents to approach their task
seriously: The leader of the free
world is counting on them.

REQUIRED SOFTWARE

♦ MICROSOFT® ENCARTA® 98/99 
ENCYCLOPEDIA DELUXE

♦ MICROSOFT® INTERNET EXPLORER 4.0

♦ MICROSOFT® POWERPOINT 97/98

SUMMARY

OBJECTIVES HOW TO BEGIN

PREREQUISITE SKILLS

TIME ALLOTTED
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Teacher Guide

Use Encarta Encyclopedia Deluxe to begin researching the Gulf War.



Whether or not you remember
the Persian Gulf War, the
events are recent enough to
make for a compelling - maybe
even passionate - discussion
about the conflict and its con-
sequences. In this activity, you
and your teammates will imag-
ine being asked to travel back
to the early 1990s to help
America's leaders make the
best decision possible. You
will bring the benefit of hind-
sight, careful research, and
intelligent debate to the task.

Fact Finding
SOFTWARE: Microsoft
Encarta 98/99 Encyclopedia
Deluxe, Microsoft Internet
Explorer 4.0

WHAT TO DO:

1. Within your team, divide up
the work of gathering basic
facts about the Persian Gulf
War. You may want one or two
people working with the print

resources in your classroom or
school library, while the other
half of the team uses the com-
puter. Halfway through your
research, you'll switch media.

2. Team members doing elec-
tronic research should start by
launching Encarta
Encyclopedia, clicking on
Encyclopedia Articles, choos-
ing Find, and using Pinpointer
to locate the extensive article
called Persian Gulf War. From
there, you can explore related
articles and follow Web links
using Internet Explorer. 

3. Focus first on pulling
together background details
and chronology about the war.
Make sure you're comfortable
with the geography of the Gulf
region, and that you can name
all the key players on both the
Coalition side and the Iraqi
side.

4. Next, look for facts, analy-
sis, and commentary about
issues like those listed in the
box on this page, keeping in
mind realities of 1990.

5. In addition to making care-
ful notes with thorough cita-
tions of your sources, be sure
to copy and save any maps,
charts, pictures, and other
visual aids that might help
your case in the debate.

6. After one class period of
research, convene as a group
and share your findings.
Identify gaps to fill and leads
worth following. Swap
research tools (computer/non-
computer) for your second
research period.

STEP A

DESCRIPTION

DESERT STORM, REVISITED
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Student Activity

Internet Explorer makes it easy to tap the wealth of war info on the Web.

DESERT STORM: QUESTIONS TO CONSIDER
üü What are America's own interests in the Gulf? 

üü What are America's responsibilities to the world?

üü What impact does the end of the Cold War have on regional conflicts?

üü What could be the cost, in economic, political, and human terms, of taking
action in a conflict like that developing in the Gulf? What could be the 
cost of not taking action?

üü What should be the goal of action in the Gulf?

üü What military resources might be necessary?

üü How might technology affect this conflict?

üü What might be some unintended consequences of such a war?



Framing Your
Arguments
SOFTWARE: Microsoft
PowerPoint 97/98, Microsoft
Encarta 98/99 Encyclopedia
Deluxe, Microsoft Internet
Explorer 4.0

WHAT TO DO:

1. After your research is com-
plete, convene as a team to
begin developing your debate
position. Ideally, each member
of the team should propose at
least one argument either for
or against - depending on the
side you've been assigned -
American involvement in the
war. Discuss all of the argu-
ments on the table, and
choose the three or four
strongest. These will form the
heart of your debate.

2. Now you need to create the
PowerPoint slides that will
serve as visual aids for your
debate. Look carefully at the
list of required slides in the
box on this page. Your whole
team could collaborate on all
the slides, or you could divide
up the work by topic.

3. When your slides are com-
plete, review them in Slide Show.
Decide which member of the
team will present each slide and
practice your presentations.

Staging the
Debates
SOFTWARE: Microsoft
PowerPoint 97/98

WHAT TO DO:

1. Each con team should put its
name on a slip of paper in a hat
with the others. Each pro team
will draw a slip to see which
con team they will debate.

2. Your teacher will assign
one pro-and-con pairing to
begin the debates. 

3. The first debaters should
meet to coordinate their initial
presentation. Each team
should print out its chronolo-
gy/overview slides and deter-
mine what key factual points
they can agree on. The teams

can then open a new
PowerPoint presentation, Copy
and Paste their relevant slides
into it, and merge their points.
Each team should name one
member to make this initial
presentation.

4. Following the overview,
each pair of teams will debate
each other in turn. All debates
will follow the same protocol:
First the pro team will present
its arguments, which the con
team will respond to. Then the
con team will make its presen-
tation, followed by the pro
team's response. Each team
can take one minute at the end
of the debate to summarize.

5. At the end of the debate,
each student should write his
or her own final stand on a
slip of paper. Your teacher will
then lead a wrap-up class dis-
cussion focusing on students'
opinions and whether they
changed as a result of
research and debate. How will
your class advise President
Bush? Should America

DESERT STORM, REVISITED
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Use PowerPoint to add powerful visual impact to your presentation.

STEP B

STEP C

YOUR SLIDES MUST INCLUDE:

üü Title Slide
üü Chronology and Overview - 

2 slides (all teams must prepare
these, but only one team cho-
sen randomly will present them)
üü Summary of Argument
üü 3-4 Arguments - 1 slide each
üü As part of argument slides or as

separate slides:
-Map
-Photo
-Spreadsheet or Graph

üü Conclusion



In and Out of
the Classroom

These self-paced guides use real-life classroom
examples to help teachers and students master
Microsoft desktop applications, including:

Office 97 Professional
Office 98 Macintosh Edition

Word 97
Excel 97

PowerPoint 97
FrontPage 98
Publisher 98

Windows 95 & 98
Works 4

Available for download now at: 
http://www.microsoft.com/education/k12/learn.htm.

MICROSOFT TEACHER RESOURCES
Helping teachers integrate technology into the classroom

Productivity in the Classroom
These classroom-tested lessons integrate a variety of Microsoft software applications, including
FrontPage 98, Office 97 and Office 98, Internet Explorer 4.0, and Encarta 99 Encyclopedia
Deluxe Edition. The lessons span the spectrum of k12 subjects and include separate teacher
and student activity pages. Download at http://www.microsoft.com/education/curric/activity.

Access these FREE resources and more at:
http://www.microsoft.com/education/k12/training.htm

Online Tutorials
These easy-to-use tutorials are designed to show teachers how to use Microsoft software in
the classroom. They were created in partnership with ACT360 Media (http://www.actden.com),
developers of interactive, online courses for teachers and students. Available tutorials include:

IE4 in the Classroom , http://www.actden.com/ie4/
Outlook Express in the Classroom , http://www.actden.com/oe/
PowerPoint in the Classroom , http://www.actden.com/pp/
FrontPage in the Classroom , http://www.actden.com/fp/

“Workshop in a Box” Kits
Managing the transition from the Macintosh to the Windows platform and from ClarisWorks 4.0
to Microsoft Office 97 & 98 is easy with these leader-led, hands-on workshops. Workshops kits
available online include Moving from Mac to Windows, Moving from ClarisWorks 4.0 to Microsoft
Office 97, and Moving from ClarisWorks 4.0 to Microsoft Office 98 (for the Macintosh). These
kits can be downloaded at http://www.microsoft.com/education/k12/learn.htm.



Microsoft® Office 97, Professional Edition for
Windows and Microsoft® Office 98 Macintosh
Edition (Academic Editions)
Office 97/98 integrates intelligent applications with the power 
of the Web. Easily insert hyperlinks between Office documents
or out to the Internet. Save your documents as HTML to 
create Web pages instantly. Office 97, Professional Edition for
Windows includes: Microsoft Excel 97, Word 97, PowerPoint
97, Outlook 97, Access 97, and Microsoft Bookshelf Basics .
Office 98 and Windows Standard Editions do not include
Access 97 or Bookshelf Basics. Office 98 includes Outlook
Express instead of Outlook.
Windows 95 , MacOS; earlier version available for Windows 3.1
Estimated Academic Price: $199.00, Professional Edition and
Office 98; $159.00, Standard Edition. Volume pricing is available.
http//www .microsoft.com/office/
http//www .microsoft.com/macoffice/

Microsoft® Internet Explorer 4.0
The fast, easy, and safe way for teachers and students to discover the World Wide Web.
Includes Internet e-mail, makes quick work of graphic displays, provides easy access to Favorite
sites and popular search engines, and supports filtering and security systems for student safety. 
Windows 95, Windows NT, Windows 3.1, and Macintosh 
FREE to download
www.microsoft.com/ie/download

Microsoft® Publisher 98 (Academic Edition)
Create effective, high-impact publications and World Wide Web sites with Publisher 98. It’s per-
fect for all your classroom and home projects. In just minutes, you and your students can turn
ideas into professional-looking publications, in print and online. In and Out of the Classroom with
Publisher 98, a teacher activity guide, is included in the Academic Edition of Publisher 98. 
Windows 95; earlier version available for Windows 3.1
Estimated Academic Price: $69.95.
www.microsoft.com/publisher/

098-81601SUPPLEMENT TO SCHOLASTIC INC.

Microsoft® FrontPage 98 (Academic Edition)
Microsoft FrontPage makes creating professional-quality Web sites effortless with powerful new
functionality, support for the latest Web technologies, and great integration with Microsoft Office.
It’s never been easier to develop and maintain your own professional Web sites!
Windows 95; earlier version available for MacOS
Estimated Academic Price: $69.95.
www.microsoft.com/frontpage/

Microsoft® Encarta® 99 Reference Suite
Encarta 99 Reference Suite for Windows combines Microsoft’s Encarta 99 Encyclopedia, Encarta
99 Virtual Globe, and Bookshelf 99 to create the world’s most comprehensive desktop reference
library. (Complete suite available for Windows 95 only; Encarta 98 Encyclopedia and Bookshelf 98
are available separately for the Macintosh.) 
Microsoft ® Encarta ® 99 Encyclopedia, Deluxe Edition - This newly updated version of
Microsoft’s award-winning, interactive multimedia encyclopedia for students and teachers turns
any classroom into a resource-rich research library. The Deluxe edition features Research

Organizer, a tool that teaches students research skills and information literacy while helping them turn Encarta infor-
mation into top-notch papers, reports, and presentations.  http//www .microsoft.com/encarta/
Microsoft ® Encarta ® Virtual Globe, 1999 Edition, the essential geographic reference companion to Encarta 99
Encyclopedia, brings you the world as never before with realistic 3-D maps, engaging multimedia, and authoritative
content. For quick facts, schoolwork, or armchair travel, Encarta 99 Virtual Globe is the newest way to visit and learn
about places, people, and cultures around the globe.  http://www .encarta.msn.com/evg98/evghome.asp
Microsoft ® Bookshelf 99 Reference Library provides ten quality desk reference works and other multimedia
resources to enrich your writing, including dictionary, thesaurus, famous quotations, and more. 
http://bookshelf.msn.com/na/default.asp
Windows 95, MacOS (Encarta 98 Encyclopedia and Bookshelf 98 only); earlier versions available for Windows 3.1
Estimated Retail Price for Encarta 99 Reference Suite: $99.95; Estimated Academic Price: $64.95, for Encarta 98
Encyclopedia Deluxe; $54.95, Bookshelf 98.

Estimated prices are subject to change without notice.

Cross-platform productivity tools
for the office and the classroom


